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PhotoBase, the Ultimate Multimedia Organizer.

PhiotoBase is a fast and easy-to-use program for
keeping track of all of your digital photographs,
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audio and video clips. An easy-to-use search tool
allows you to locate pictures by a description. Once
you locate an image, PhotoBase provides drag and

drop functionality to move your image to a document

or presentation program.

B Use PhotoBase to create picture Slide Shows to
distribute your pictures to others.

B Print Albums or create product catalogs with
frames, backgrounds and descriptions.

W Crop and Edit your images with easy to use

enhancement tools.

PhotoBase Features

B Notes to store your images with descriptions
and locations for easy identification.

B Keyword "Search" feature provides easy-to-use
search tools for locating images.

B Combine images from different albums to tell a
story or create a unique album.

MW Create Slide Show CD's, floppy disks, or
removable media to send images to others.

M Print aloums complete with descriptions and
frames in large, medium or small formats.

B Drag-and-drop functionality to quickly use an
image with most document and presentation
programs.

B Live Capture options include snapshot and
movie video capture using Video-For-Windows-
compatible devices.

B Hot Links add your preferred programs to the

tool bar, such as image editing, page layout,
word processor, Internet browsing and
entertainment applications




ArcSoft PhotoBase Software License Agreement

The following is a legal software license agreement between you, the software end user, and ArcSoft, Inc. Carefully read this
license agreement before using the product. Using the product indicates that you have read this license agreement and agree
to its terms.

Grant of License. This license permits you to use ane copy of the software included in this package on any single computer. For
each software licensee, the program can be "in use" on only one computer at any given time. The software is 'in use" when it is
either ipaded into RAM or installed into the hard disk or other permanent memory. A special license permit from ArcScoft is
required if the program is going to be installed on a network server for the sole purpose of distribution to other computers.

Copyright. The software contained in this package is owned by ArcSoft and is protected by United States copyright laws,
international treaty provisions, and all other applicable national laws. The software must be treated like all other copyrighted
materials (e.g. books and musical recordings). This license does not allow the software to be rented or leased, and the written
materials accompanying the software (if any) may not be copied.

Limited Warranty. ArcSoft, Inc., warrants that the software contained herein will perform substantially in accordance with the
accompanying documentation.

No Other Warranties. ArcSoft disclaims all other warranties, either express or implied, including but not limited to implied
warranties of merchantability and fitness for a particular purpose, with respect to the Software, the accompanying written
materials, and any accompanying hardware (if any).

No Liability for Consequential Damages. In no event shall ArcSoft or its suppliers be liable for any damages whatsoever
(including but not limited to damages for loss of business profits, business interruption, loss of business information, or any other
pecuniary oss) which results from an inability to use this software, even if ArcSoft, inc. has been advised of the possibility of
such damages. Because some states/jurisdictions do not allow the exclusion or limitation of consequential or incidental
damages, the above limitations may not apply to you.

U.S. Government Restricted Rights. The Software and documentation are provided with Restricted Rights. Use, duplication, or
disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (¢)(1)(ii) of the Rights in Technical Data
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (¢)(1).(2), and (3) of the Commercial Computer
Software - Restricted Rights at 48 CFR 52.227-19, as applicable, and any amendments thercto. The manufacturer is ArcSoft,
Inc., 46601 Fremont Blvd, Fremont, CA 94538,

If this product was purchased in the United States, this Agrecment is governed by the laws of the statc of California; otherwise,
local laws may apply.
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Arcsoft PhotoBase

Minimum System Requirements
Windows 95 or Windows NT

8 MB RAM

16-bit or 24-bit Super VGA display
25 MB free hard disk space
Sound Card

Important Release Notes

Windows NT Users: PhotoBase is only supported for
use under Windows NT 4.0 with Service Pack 3
applied. PhotoBase will not function properly in
Windows NT without Service Pack 3.

Windows 95 and NT Users: When using the "Send"
feature in the Image menu only one image can be
sent to your e-mail program and attached to a
message at a time.
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GETTING STARTED

1) Insert Disk 1 of the Digital Image Productivity
Software Suite.

2) Click the Start menu and select Run.

3) Click on Browse, then double-click on the PBase
folder.

4) Click on Setup.exe, then click open.
5) Click on OK to begin installation.
6) Follow the prompts in the installer.

Start Photobase by selecting the Start menu,
Programs, ArcSoft, then PhotoBase.

Click on the Aloum area where it currently says [New]
and select Sample Photos.

These small pictures of images are known as
“thumbnails.” Click once on an image. The information
area below the thumbnail images is now specific to
the selected image. You can edit the text and even
the names of the labels as needed.

Double-click on an image thumbnail to view or edit
the image. PhotoStudio will open displaying the
selected image.

To add an image to an album, click aon the Add tool.
PhotoBase supports most popular image file formats
in addition to audio and video. After adding your
image, type a brief title and description to document
your image for future reference.

PhotoBase has the ability to work with ALL file types
to organize video, audio, Internet and document files.
When adding files to your album, change the Files Of
Type field from All Image Files to All Files. PhotoBase
will create an icon that denotes the file type. If you
double click on any of these files, the “associated”
Windows program for opening that type of file will
launch with the image.

PhotoBase supports importing images and sounds
directly from your Ricon RDC-4300 digital camera into
PhotoBase.

After modifying the images or information fields in an
album click the Save icon to save the album.

The Print tool will create custom print pages of
selected images or a whole album of images. You can
select Small (16 per page), Medium (9 per page), or
Large (4 per page) images and select from a number
of options including the addition of frames,
backgrounds, and descriptive text.

The order your thumbnails appear in the album can
be rearranged by selecting the Sort tool from the
toolbar. The thumbnails can be arranged in
alphabetical order or by date. You can also rearrange
the order manually by dragging and dropping images
within the album.

To remove thumbnails from your album, select the
ones you'd like to remove and click on the Delete
icon. Important note: deleting will only remove the
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thumbnail, not the original image file. If you want to
delete the image also, you must check the Remove
Image File(s) From Disk checkbox on the Delete
confirmation window.

You should now be ready to select [New] from Album
and begin creating an album of your own images.

Using Images With Other Applications

Add short cuts to your favorite programs on the
Application Toolbar in PhotoBase. You can then drag
a desired file from the album to the application's icon
cn the toolbar to launch the program along with the
file. Simply right click with your mouse on the lower
tool bar to add an application.

PhotoBase also supports drag and drop capabilities
to use your images with many document and
presentation programs. Select the image with the right
mouse button and while holding down on the button,
drag the image to your destination program.

Create Slide Shows

PhotoBase can play a Slide Show of your entire
album, or a group of files in your album. Options
include adding an audio soundtrack or attached
audio files to create a multimedia presentation. The
third description field for each image will also be
displayed with each image. Add effects to create
transitions between images and Auto-Loop for
continuous play of the selected album.

The Create Slide Show icon provides options to create
a Slide Show presentation of your images. Create a
portable Slide Show that can sent to others on CD,
floppy, or other removable media.

Using Image Information Effectively

The text you type into the Information fields has
multiple uses so it's important to understand them to
get the most out of PhotoBase.

The information is useful for finding specific kinds of
images. The Search command in the Image menu
allows you to search among all or selected albums for
a specific word. PhotoBase search results can be
included in a new or an existing album.
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MENU COMMANDS

PhotoBase utilizes simple menu commands to aid in
creating your image albums:

1. Album Menu

2. Edit Menu
3. View Menu
4. Image Menu
Album Menu

The Album menu contains commands for
manipulating and managing albums:

New

This command creates a new empty photo album.
You may add images to this album from other albums
or from any selected source.

Open

This command allows the user to open an available
album,

To use the Open command:

Once the Open dialog box appears, click on an
album from the list then click OK. To exit without
making a selection, click Cancel. This function may
also be done from the tool bar using the puil down
menu next to Album:

Rename

This command allows the user to rename the current
album.

To use the Rename command:

Once the Rename dialog box appears, type in the
new name for album then click OK. To exit without
renaming, click Cancel.

Duplicate

This cormmand allows user to create a duplicate of the
current album to create a backup or modify an
existing album.

To use the Duplicate command:

When the Duplicate dialog window appears, type in a
new name for the duplicate aibum. Choose a new and
unique name for the duplicate album.

Move To

This command moves ALL image or sound files
associated with the current album from the current
drive(s) to a new destination/directory. This feature
can be used to free available hard disk space by
moving files to an external storage device. By moving
images with this feature, PhotoBase will still be able to
find the images.

To use the Move To command:

In the window, enter a new directory or click Browse
to select path. Once path is selected in the browser,
be sure to choose Select to confirm destination. Next,
select Move in the Move To window. Note: the image
files associated to the current album will be removed
from their current locations when this command starts.

Properties
This command displays the current albums Properties
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in a pop-up window. The Properties information
includes: the Filename/Directory where the album file
is located, the number of Thumbnails in the album,
the file size of the album, and the album description if
available.

New Album Window

This command opens other albums (new or existing)
in a new window. Use this feature to combine or move
images or audio to/from different albums or to work
with multiple open albums simultaneously.

To use the New Album Window command:

When pop-up window opens, choose an album and
select OK.

Save Album

This command saves changes to the active album.
Print

This command provides the controls for the Print
options. There are many options available for creating
custom printed pages of selected images or the entire
album.

Select the Print command.

Choose from the following options:

Print Context:
All Thumbnails: This will print every image included in
the active album.

Selected Thumbnails: This will print only the
thumbnails that you have selected in the active
album.

1) To select an image, click on the image once
with your left mouse button.

2) To select multiple sequential images,
depress the shift key while selecting images.

3) To select multiple non-sequential images,
depress the contro! key while selecting images.

Range: This will print images using the number
assigned to each image in the album. In From specify
the first image by this number and In To specify the
last image of the range to be printed.

Header: Type in a name or description to include a
header at the top of the album page. If no text is
included, the header will print blank.

Print Quality: Select Low Quality for faster printing
when low resolution is preferred. For best results, use
low quality with Small Print Size only. Select High
Quality for the best color and sharpness of your
images.

Print Size: Small will print images in the thumbnail size

for the maximum number of images per page. Up to
(16) images can be printed on a 8.5x11” size paper.
Medium will print larger images. Up to nine images
can be printed on a 8.5x11" size paper. Use High
Print Quality with Medium size images for best results.
Large will print the maximum size with up to four
images per 8.5x11” size paper. Use High Print Quality
with Large size images for best results.

Choose to include the following options by clicking on




the check box. To disable, click on it again and
remove the check from the check box.

Print Description Text: prints the information included
in the three description fields for each image. The
descriptions will print beneath each image. Disable
Description text and the image will center to fill the
frame without descriptions.

Print Uniform Image Size: centers and crops the
images to fit a uniform print size for all of the images
regardless of the original picture format. This will
create a unified look for the entire albumn. Disable to
print the images with the aspect ratio of each image.

Print Page Number: prints page numbers at the
bottom center of each page. Disable to print without
page numbers.

Print Multimedia: Thumbnails: prints thumbnails of all
file formats included in an album. Disable to print only
the image files such as JPG, BMP, TIFF, etc...

Border Options, Print Frame: Select the check box to
print a frame around each image.

Print Background: Select the check box to add a
background (or matte) to the frame for each image.

Select a Frame and Background: Drag the slider to
view the selections of frames and backgrounds to be
printed. Select the desired frame and/or background
using the left mouse button and the frame/background
will appear pushed in to show that it is selected.

Print Preview: shows a preview of your print selection.

Print: prints the current selection with the enabled
options.

Cancel: to exit without printing.

Print Setup

This command chooses which printer to use, paper
size, orientation, portrait/landscape layout, etc...
Slide Show

This command runs a full screen Slide Show
presentation of an existing album.

To use the Slide Show command:

Choose to turn on or off:

1) Auto-loops: provides a continuous playing loop of
slide show

2) Eftects for a transition between each image
displayed

3) Slide Show (#) Seconds sets the amount of time
each image is displayed on the screen

4) Press ESC to end the slide show
Note: Slide Show will play JPG, BMP, TIFF, TGA, PCD,

PCX and GIF files. All other files will not play or be
skipped over in the album sequence.

Field Label

This comrnand modifies the naming of the description
labels for the thumbnails. Customize your album for
many applications such as name, date, location,
price, part number, etc... Change these descriptions
as needed. Note: Opening an album created with
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different field names will not change the field names,
this must be manually changed as needed.

To use the Field Label command:

Enter new label for field in space provided, up to
fifteen characters per Field.

Setup Applications

This feature allows you to add your favorite
applications to the lower tool bar in PhotoBase. You
can then drag a desired image to the applications
graphic icon and launch the program along with the
image file. Compatible applications include many
popular programs, but be aware of the file formats
that are compatible with each program to make sure
your image will open properly.

To add an application, you may double click with your
left mouse button on the bottom tool bar or seiect
Setup Application from the Album menu.

Select Application:

With your left mouse button, press on the Select
Application button and using the browser, find the
executable file for the application you wish to add. For
a demonstration of this feature, select the Microsoft
Paint program included with Windows located in your
Program Files directory in the Accessories Sub-
directory.

Name: Type in a name for the Application.

Add Application: Select add application and a
program icon will now be created in PhotoBase.

Remove Application: To change an application, simply
use the left mouse button and select the icon. This will
open the setup application dialog and you may
change or remove the application.

Tips: Drag your image to the icon and PhotoBase will
launch the assigned application along with the
selected image. A right mouse click on an icon will
launch the desired program without an image.

Exit

This command closes the current PhotoBase window.
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EDIT MENU

The Edit menu contains commands for editing album
images:

Cut

This command removes the selected image from the
current album and places it on the Clipboard. The
image can be Pasted into a new album or into a
compatible program.

To use the Cut command:

Select a thumbnail, and then click the cut command
from the Edit menu.

See Related topics:
Copying Selections
Pasting Selections

Copy

This command copies the selected image in the
album and places it on the Clipboard. The original
image is not changed. Copy images to new album or
to a compatible program.

To use the Copy command:

Select a thumbnail, and then click the copy command
from the Edit menu.

Related topics:
Cutting Selections
Pasting Selections

Paste

This command pastes images from the Clipboard into
the current album or into other compatible programs.
To use the Paste command:

Select a location or a new album, and then click the
paste command from the Edit menu.

See Related topics:
Cutting Selections
Copying Selections

Delete

This command remaoves the selected thumbnail
images from the album. It is important to note that the
user has the option of removing only the thumbnaits in
the album or removing both the image file and
thumbnails. Removing the image file is permanent
and will not be recoverable.

To use the Delete command:

Select a thumbnail(s), and then click the delete
command from the Edit menu.

Note: The Delete command is not available if there is
no seiected images in the album.

Sort

This command will sort the current album in a
selected manner.

To use the Sort command:

Click the Sort command from the Edit menu. Choose
from the following sort options:

1) Name- by the file name.

2) Type- by the file type or extension (.BMP, .JPG,
TIF, etc.).

3) Size- by the size of the file.
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4) Date- by the date the file was created.

5) Description—- By the first number/letter in the
Description field (or Field Label 3).

6) Reverse-sort in reverse order any of the above
selections.

B Add Image
This command adds a new image to the album.

To use the Add Image command:

Click the Add Image command from the Edit menu.
Choose the source/directory. Highlight the selection,
and click to add.

Note: Image file types include many popular digital
formats. Open the Files of Type pull down list at the
bottom of the Add image dialog box to find unlisted
file types. To select a file type not included in the list,
scroll down the list to All files. This will allow any file
type to be inserted in the atbum.

Tip: The purpose of this feature is to include all text
and database files associated with image files in an
album.

H TWAIN Acquire

This command allows you to get digital images
through a selected TWAIN device.

To use the Acquire command:

Select Acquire, a dialog box appears for choosing a
device, and then it's TWAIN interface dialog box
appears with options that apply to your devices.

B Capture

This feature will allow you to capture still images and
video clips by using your installed Video for Windows
compatible source, or a sound clip by using your
sound card. Compatible hardware includes most
desktop cameras, video capture cards/adapters and
digital cameras. Check with your device manufacturer
if you are unsure of compatibility.

1) To Capture a still image: Use the right mouse
button and select Get Image.

Possible Options:
Get Image: performs a still image capture of the
currently displayed video image.

Edit Image: opens the edit window and provide tools
for adjusting your captured image.

Save Image: specifies the location and file type you
wish to use to save the captured image. If you do not
select Save Image, the image will be automatically
deleted.

2) To capture a video clip with sound: Use the right
mouse button and select Get Video. Make sure the
audio source is attached to the input of the sound
card.

Possible Options:
Get Video: PhotoBase will begin capturing, press your
computer's escape key to end the capture

Play Back: plays back the captured clip.




Save Video: provides you with a browser to save your
captured clip to any desired location. PhotoBase
automatically saves images in the AVl format and will
create an image icon in the current album. If you do
not select Save Video, the clip will be automatically
deleted.

Other Options:

Driver Options

Driver List: provides a pull down menu with all drivers
currently loaded on your system for capture. If you do
not see your driver in this menu, refer to your
appropriate hardware manual for proper installation.

Format: provides video format options available for
your specific video hardware.

Source: displays additional options specific to your
hardware.

Display: allows you to adjust the capture preview
video display.

Video Capture Options: refer to your video hardware
instruction manuail for details on these settings:

Frame Rate: how many frames per second of video
(hardware dependent).

Video Buffer: how many video frames to buffer
(hardware dependent).

Set Compression: the type and degree of
compression for your video capture (hardware
dependent).

Audio Capture Options: refer to your audio hardware
instruction manual for details an these settings

Capture Audio: enable this feature if you wish to
record audio with your video using Windows
compliant audio capture devices.

Set Audio: opens audio settings for your audio
capture hardware.

Download Image
This command copies image files from your camera to
FhotoBase.

To use the Download Image command:

Select the correct Serial port and download speed for
your system from the Options For RDC-4300 dialog
then click on OK.

The Download image dialog will appear. A preview of
the current image is displayed in the upper right of
the dialog. If you'd like to download this image click
on the Current Frame checkbox just below the
preview image. Use the arrow buttons ( << and >>) to
see the other images currently stored in the camera.
Use the Current Frame checkbox to select any other
images to be downloaded. The Select All button can
also be used to download alf images currently stored
in the camera. The location to download images to
can be changed by clicking on Browse. Images are
not deleted from the camera when downioaded. When
the desired images are selected click on OK to

26

proceed with downloading the images to PhotoBase.

Note: Images which have a sound annotation
recorded by the RDC-4300 are noted in the album
by a music note in the upper right hand corner of
the thumbnail. To play the attached audio, simply
select the thumbnail image containing the
altached audio and right-click with your mouse. A
menu will appear providing options for playback,
detaching sounds and attaching sounds.

Upload Image

This command copies image files from PhotoBase to
your camera.

IMPORTANT NOTE: The image upload to camera
functions of DU-4 and PhotoBase will support
ONLY sound that has been captured with your
RDC-4300 camera

To use the Upload Image command:

The Upload Image dialog will appear. A preview of the
current image is displayed in the upper right of the
dialog. If you'd like to upload this image click on the
Current Frame checkbox just below the preview
image. Use the arrow buttons (<< and >>) to see the
other images currently selected in PhotoBase. Use the
Current Frame checkbox to select any other images to
be uploaded. The Select Ali button can also be used
to upload all images currently selected in PhotoBase.
Images are not deleted from the PhotoBase when
uploaded.

When the desired images are selected click on
Upload To Camera to proceed with uploading the
images to the camera. Select the correct Serial port
and speed for your system from the Options For RDC-
4300 dialog then click on OK.

If you have a Smart Media reader you can use Copy
To Disk to upload to the media instead of uploading to
the camera.

Auto Enhance

This command performs several modifications to
images that tend tc improve the guality of digital
camera images. From the preview, you will have the
option to keep or cancel the Auto Enhance changes.
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VIEW MENU

The View menu contains commands for managing the
PhotoBase work space, and shows information about
the status of images.

Status Bar

This command will show or hide the Status Bar. A
check mark is displayed next to this option when the
Status Bar is active.

IMAGE MENU
The Image menu contains commands for:

Search

This command allows the user to search for a specific
image in selected albums. The search result can be
stored in a new album or in an existing album.

To use the Search command:

When you are in the Search dialog box, choose the
album(s) you want to search from, and then choose
an album that you would like to store the images in.
You can refine your search to a specific Field or
Filename by de-selecting any of the search field
options.

Make Slide Show

This command allows the user to create a portable
slide show disk (floppy, CD, remavable storage or any
hard drive) based on selected images from any
album. By using this command, one can create a
disk that contains the image player and all images
selected for the slide show. This allows one to create
a truly portable slide show.

There are two ways to make a slide show:

1. Select the images in your album that you want to
include in your slide show and then select the Make
Slide Show command. Then choose a destination
drive floppy, hard drive, external storage device, etc.
Once destination is chosen, select copy to begin
making your slide show.

2. Select the Make Slide Show command, choose
images from the Thumbnail List for your slide show.
Then choose destination floppy, hard drive, external
storage device, etc. Once destination is chosen select
copy to begin making your slide show.

Tip: PhotoBase will display the memory requirements
for the selected images and the available space on
your destination disk. Before selecting copy, confirm
that your destination disk contains enough disk
space.

Create Copy
This command will copy all selected images to a new
location.

To use the Create Copy command:

When window appears, choose the destination
directory for the selected image(s). Once destination
is chosen be sure to click select in the path window to
confirm selection.

Send
This command sends an e-mail message with the
active image as an attached file.
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Send will automatically look for a MAPI compliant
e-mail program on your system. In the event that your
e-mail program is not MAP{ compliant, use the normal
file attachment procedures supplied from your e-mail
provider.

To use the Send command:

Select the image thumbnail, whose file needs to be
sent as an attachment, and then choose Image/Send.

TOOLS

You can access some of the frequently used
commands through Tool buttons.

Add Image Tooi
This tool adds a new image to the
album.

i To use the Add Image tool: Click on the
* tool button. Choose the source/directory.
Highlight the selection, and click to add.

Note: Image file types include many popular digital
formats. Open the Files of Type pull down list at the
bottom of the Add Image dialog box to find unlisted
file types. To select a file type not included in the list,
scroll down the list to All files. This will allow any file
type to be inserted in the album.

Tip: The purpose of this feature is to include all text
and database files associated with image files in an
album.

. Download Image Tool
B This tool copies image and audio files
from your camera to PhotoBase.

To use the Download Image Tool:

Click on the Download Image Tool.
Select the correct Serial port and download speed for
your system from the Options For RDC-4300 dialog
then click on OK.

The Download Image dialog will appear. A preview of
the current image is displayed in the upper right of
the dialog. if you'd like to download this image click
on the Current Frame checkbox just below the
preview image. Use the arrow buttons (<< and >>) to
see the other images currently stored in the camera.
Use the Current Frame checkbox to select any other
images to be downloaded. The Select All button can
also be used to download all images currently stored
in the camera. The location to download images to
can be changed by clicking on Browse. Images are
not deleted from the camera when downloaded. When
the desired images are selected click on OK to
proceed with downloading the images to PhotoBase.

Upload Image Tool

This tool copies image and RDC-4300
audio files from PhotoBase to your
camera.




IMPORTANT NOTE: The image upload to camera
functions of DU-4 and PhotoBase will support
ONLY sound that has been captured with your
RDC-4300 camera.

To use the Upload Image toot:

Click on the Upioad Image Tool. The Upload Image
dialog will appear. A preview of the current image is
displayed in the upper right of the dialog. If you'd like
to upload this image click on the Current Frame check
box just below the preview image. Use the arrow
buttons ( << and >>) to see the other images
currently selected in PhotoBase. Use the Current
Frame checkbox to select any other images to be
uploaded. The Select All button can also be used to
upload all images currently selected in PhotoBase.
Images are not deleted from the PhotoBase when
uploaded.

When the desired images are selected, click on
Upload To Camera to proceed with uploading the
images to the camera. Select the correct Serial port
and speed for your system from the Options For RDC-
4300 dialog then click on OK.

If you have a Smart Media reader you can use Copy
To Disk to upload to the media instead of uploading to
the camera.

Auto EnhanceTool

Click on this tool to automatically
perform several modifications to images
that tend to improve the quality of digital
camera images. From the preview, you
will have the option to keep or cancel
the Auto Enhance changes.

Save Album Tool
This tool saves changes to the active
album.

Print Tool

This tool provides the controls for the
Print options. There are many options
available for creating custom printed
pages of selected images or the entire
album. Please see Section I, Menu
Commands for more information.

Sort Tool

This tool will sort the current album in a
selected manner. To use the Sort
command:

Click the Sort Tool. Choose from the
following sort options:

1) Name - by the file name

2) Type - by the file type or extension (.BMP, .JPG,
TIF, etc.)

3) Size - by the size of the file.
4) Date - by the date the file was created.

5) Description - by the first number/letter in the
Description field (or Field Label 3)

6) Reverse - sort in reverse order any of the above
selections.
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Delete Tool

This tool removes the selected
thumbnail images from the album. It is
impaortant to note that the user has the
option of removing only the thumbnails
in the album or removing both the image file and
thumbnails. Removing the image file is permanent
and will not be recoverable.

To use the Delete tool:
Select a thumbnail(s), and then ¢lick the Delete Tool.

Note: The Delete command is not available if there is
no selected images in the album.

Make Slide Show Tool
- This tool allows users to create a

== portable slide show disk (floppy, CD,
__J removable storage or any hard drive)

based on selected images from any
album. By using this command, one can create a
disk that contains the image player and all images
selected for the slide show. This allows one to create
a truly portable slide show.

There are two ways to make a slide show using this
tool:

1. Select the images in your album that you want to
include in your slide show and then click the Make
Slide Show tool. Then choose a destination drive
floppy, hard drive, external storage device, etc. Cnce
destination is chosen, select copy to begin making
your slide show.

2. Select the Make Slide Show tool, choose images
from the Thumbnail List for your slide show. Then
choose destination floppy, hard drive, external storage
device, etc. Once destination is chosen, select copy
to begin making your slide show.

Tip: PhotoBase will display the memory requirements
for the selected images and the available space on
your destination disk. Before selecting copy, confirm
that your destination disk contains enough disk
space.

AUDIO COMMANDS
Playing Back Audio Files From Within An Album

Audio files without attached images are ncted in the
album as a pair of headphones. To play back an
audio file, simply double-click on the thumbnail of the
audio file.

Images With Attached Audio

Note: Images which have a sound annotation
recorded by the RDC-4300 are noted in the album
after downloading by a music note in the upper right
hand corner of the thumbnail. To play the attached
audio, simply select the thumbnail image containing
the attached audio and right-click with your mouse.
A menu will appear providing options for playback,
detaching sounds and attaching sounds.
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Attach Audio

Select this command to attach an existing WAV file to
an image file for later playback.

Play Attached Audio

This command plays any WAV file attached to the
currently selected image file.

Detach Audio

Remoaves the audio currently attached to the file. (The
WAV file is not deleted from the disk, only detached
from the image file.)

ADVANCED FEATURES

Work With Other Image Applications Directly

You can add short cuts to your favorite applications to
the lower tool bar in PhotoBase. You can then drag a
desired image to the application's graphic lcon and
launch the program along with the image file.
Compatible applications include many popular
programs, but be aware of the file formats that are
compatible with each program to make sure your
image will open properly.

To Add An application:

You may double click with your left mouse button on
the bottom tool bar or select Setup Application from
the Album menu.

Select Application:

With your left mouse button, press on the Select
Application button and using the browser, find the
executable file for the application you wish to add. For
a demonstration of this feature, select the Microsoft
Paint program included with Windows located in your
Program Files directory in the Accessories Sub-
directory.

Name:

Type in a name for the Application.

Add Application:
Select add application and a program icon will now
be created in PhotoBase

Remove Application:
To change an application, simply use the left mouse
button and select the icon. This will open the setup

application dialog and you may change or remove the
application.

Tips: Drag your image to the icon and PhotoBase will
launch the assigned application along with the
selected image. A right mouse click on an icon will
launch the selected program without an image.

Drag and Drop (to move or insert Image):

Holding down on the left mouse button on an image
will allow you to drag an image(s) to another album or
location within the current album. Releasing the left
button will insert the image(s) to the new location.
This feature can be used to organize a Slide Show
presentation or Printed Album.

Drag and Drop to move or insert an image in
another application:

Drag and Drop can also be used to insert an image in
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compatible programs such as Microsoft Office and
many other programs. This feature will only move one
image per “drag” selection. The selected program
must support file insertion for the selected tile type!

Right click on an image to open the image editing
functions:

Edit: to open the image to view and
alter the image file.

Cut: to move the image to a new
album or application.

Copy: to Copy the image to a new
album.
Paste: to Paste the image to a new

album.

to link a WAV file to the
selected image file

Play Attached Audio: to play a .WAYV file linked to the
selected image file

to update the Thumbnail image
with any changes made to the
image file.

View Image Full Size (Open File)

Double click on any image with your left mouse button
to view the image full size. If the image file type is not
supported by PhotoBase, the image will open with the
associated Windows program used to create the file.
For example, a .wri write file will open with WordPad.
Short Cuts

Using Windows Explorer, you may create a short cut
on your desktop to as many albums as you like. This
will allow you to open a specific album directly from
your desktop. Simply select using the right mouse
button any *.phb file in the PhotoBase Album
directory, hold down the right mouse button and drag
the album file to your desktop to create a short cut.

Use Of ALL File Types In PhotoBase

Multimedia Image file types include many popular
digital formats. PhotoBase also supports non-
multimedia file types to include all text and database
files associated with image files in an album.

Tip: Internet animated GiF and HTML pages can be
archived and documented for future locating using
the search feature. Files can be organized and
opened with any browser.

To add a non-image file type, at the bottom of the Add
Image dialog box, open the Files of Type pull down
list to find unlisted file types. Scroll down the list to
All files. This will allow any file type to be inserted in
the album.

CUSTOMER SUPPORT

Getting Help! For problems with PhotoBase software,
refer to the software application's Online Help first.
Online Help is available in PhotoBase by pressing the
F1 key or from the Help menu.

Attach Audio:

Refresh:

Visit ArcSoft at http://www.arcsoft.com for information
on updates and upgrades.




